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Setting up a WLS-Webservice Example in Eclipse

| like the API Examples that ship with WLS because they contain a level of complexity that is
just enough to demonstrate the technology slice at hand. In other words, they are kept very
simple. Therefore they are an excellent starting point for small test applications that can be
used in very complex environments. We want to look at the Example: “Creating a Web
Service from an Existing WSDL File”. We demonstrate how to quickly integrate it into
Eclipse with full support of code completion, context sensitive help and on-the-fly compilation

support.
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2 The Example from WLS

Let’'s have a quick look at the example itself. It is just a simple web service called
“TemperatureService” that is called from a stand-alone java client, as depicted in the following
diagram.

Scorpio
Win7, i7-QM 2,4GHz, 4GB RAM
WLAN 192.168.0.24

TemperatureClient.java

{5} TemperatureService

getTemp()

Figure 1. Web service Example with a stand-alone Java Client calling a web service on
the example server.

This example demonstrates the build process of a web service starting from a wsdl file, which
is depicted in the following diagram.
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D TemperatureService.wsdl . .
[ input——m @ clientgen
portType name="TemperaturePortType"

‘ generate

input
TemperaturClient.java

@ wsdlc

destJIwsDir="${temperatureJwsDir}"
destImplDir="${temperatureImplDir}

i $temperaturedwsDir
\—@ TemperatureService_wsdl.jar

TemperaturePortType.java

generate @ Data Binding Artefacts
input
L p iy ${temperatureImplDir}

L TemperaturePortTypeImpl.java
o . . | input
Your Business Logic i dit ? ne #
{ ; edit
>
i public float getTemp(zipcode) i q
¥ @ jwsc
) return 101.6f t destdir="¢{temperature.ear}"

jws: file="TemperaturePortTypeImpl.java"

generate——— P iiE temperature.ear

L@S} TemperaturService )

Figure 2. Build-Process of the web service.

The process starts from the file TemperaturService.wsdl. The ant task wsdlc generates a JWS
file TemperaturPortTypelmpl.java which is a stubbed out web service template. We insert our
business logic in this file. The wsdlc task also generates a JAR file containing additional
artifacts, needed to compile the web service. These two elements comprise the input for the
jwsc ant task which eventually generates the deployable web service. The file
TemperaturService.wsdl also serves as input for the client which is generated and built by the
clientgen ant target.

We find the documentation for this example on the help page of our example server
http://localhost:7001/docs/server/examples/src/examples/webservices/wsdl2service/instructio
ns.html?skipReload=true. For convenience we provide a link to a PDF copy here.

3 Setting up the Example in Eclipse

Now let’s turn to the hands-on work. We want to set up the example in Eclipse to be able to
run and modify it. However we do not change the build workflow because we want to
demonstrate a quick solution. As we will see later there is a conceptual gap between the
standard way of the Eclipse IDE to build web services, and the example from WLS. We can
imagine the WLS example as an external build like it is normally used in software
development projects, supported by cruise control or maven.
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3.1 Creating a Java Project

In Eclipse we create a new Java Project with the new project wizard as depicted in the
following figures.

® v ETE) (v IR [ 3 mevme o R, e
1| Select a wizard — Create a Java Project. » Jl Java Settings o JJ
§| crestea i project Create  Java project in the workspace of in an external location Define the Java build settings [y

& Source I Projects | i Libraries | “; Order and Export

~ Details

@ N > cancel

is if you have a folder in ystem that should be |
er.

Working sets
to the incl d excusion

ing and excluding each falder or fie manvally.

add project to working sets
Allow output folders for sourge folders
Default output folder:

(@ The wizard wil automatically configure the JRE and the project layout based an the existing
source. webservices wsdizservice/bin Bromse...

@ < Back we> || Fmish | [ cane @

T—
< Back N emsh ) concsr |
—

Figure 3. Dialog to create a new Project.

In the first step we choose the Java Project nature, since we want to use eclipse’ JDT features.
In the next step we provide the name webservices-wsdl2service for the project. We could
choose any name but we stick to the proposal of the example documentation here.In the last
step we remove the folder src from the build path because we want to set up our own built
path from the pre-existing file structure of the example.

3.2 Importing the WLS example

In this step we will import only a single example from the collection of api examples. We
therefore have to made some ajustments to the path settings.

We right-click on the new project in the package explorer and choose import to import the

example files from weblogic samples directory. This is a two-step dialog as depicted below:

Select \ File system —
L : =
Import resources from the local fle system into an existing project. [k | Import resources from the local file system, 2
Select an import source: From dirmml DA\100racle\01M e\wlserver 12.1 ] er les\srcy i dizservice I -
type filter text — —
= General s di2senvice) ﬂsﬂ]bund xml
= ¥
. Archive File v F example.xml
= FPFSTET into Workspace [¥1 Es instructions html
&= ovs
= EB
& Git
& nstal P
& Java EE fiter Types... | | SelectAl | [ DeselectAll
2 Plug-in Development
= Run/Debug a Into folder: webservices-wsdiZservice
Options.
Elouanusita.axistingsasaurces without warning
[¥] Create top-level folder
@ s o
®

Figure 4. Dialog to import the sample into the projcf.
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In the first step we choose to import from the file system. In the next step we navigate to the
example files of the WLS distribution. We select the directory for import and confirm that we
want to use top-level folder and conclude the dialog.

In the same manner we import the file example.properties which currently not par t of the
project.

- = = -
Select . —
N N File system
Import resources from the local file system into an existing project. E:ll]
Import resources from the local file system. d
Select an import source:
type fiter text From director: D100racle\01Middleware\wlserver_12.1\samples\server\examplesisrc Iv
& General -
G, archiveFile CEES [¥] B examples.properties
into Workspace
[l
L Preference: [l
@ s !
= EB [l
@ Git
& Install m [
= Java EE
(& Plug-in Development. [l
 Run/Debug |
i l Filter Types... ] I Select All ] I Deselect All
|| Into folder}| webservices-wsdl2service
@ v oma) | | omton:

[ | Overwrite existing resources without warning
|| Create top-level folder
1

L
@ Next > l Finish ][ Cancel

R—

Figure 5. Importing example.properties into the project folder.

We navigate to the file and select it. This time we unselect “Create top-level folder” because
we want the file to be placed directly in the project folder.

Now we have to make some adjustments to the example.properties and the build.xml files to
reflect our slightly diverging file structure.

In the example.properties file we comment the property examples.home.dir and instead
change it to a relative path, pointing to the parent folder, which is the basis for all ant
operations.

[F) Project Explorer &2 [# package Explurer] = | R examples.properties
ij webservices-wsdl2service {; ;i;p;;;:;agl AAAAAAAAA
& src 16wls.username=weblogic
5% wsdl2service/client 17 wls.passuword=welcomel
=k JRE System Library [jdk160 29] 12wls.server.name=examplesServer
N - 19
(= wsdl2service
- 20###  Examples src and domain directory locations ###
(= client 3 - - N N L
(= dist 2R#examples.home.dir=D:/180racle/@1Middleware/ulserver_12.1/samples/server/examples
(= output 21 examples.home.dir=. ./
(= wsdl files 2,
£ build.xml 25 examples.domain.dir=D:/180racle/@iMiddleware/wlserver_12.1/samples/domains/wl_server

26 -- Examples locations.

27 examples.src.dir=${examples.home.dir}/src

28 examples.build.dir=${examples.home.dir}/build

20 auto.deploy.dir=§{examples.domain.dir}/autodeploy

%] examplexml

examples.properties,
L= webservices-wsdl2service? 2eclient.classes.dir=%{examples.build.dir}/clientclasses

Figure 6. Adjusting the examples.properties file.

In the build.xml file we adjust the path which points to the example.properties file.
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rl\jProjs:ct Explor =4 Package Expl &2 = 54 buildxml 2
El s ¥ 1 k2xml version="1.8" encoding="IS0-8859-1"2?>
2= <project name="webservices-wsdl2service"” default="3ll" basedir=".">

2 webservices-wsdI2service

@ src

4 <!-- set global properties for this build --»
2 wsdl2service/client 5
=i JRE System Library [jdki60_29] 6 <property file="../examples.properties"/»
= wsdl2service 7
8 <property name="example.output” value="%{basedir}/output”/»

utput_trash
(& output tras 9 <property name="dist" value="${basedir}/dist"/>

(= dist 19
EWEOeS 11 <!-- Temperature WS Directories --»
%1 build.xml 12 <property name="temperature.dir" value="${example.output}/temperature"/>
(% example.xm 13 <property name="temperaturelusDir" value="%${temperature.dir}/jus"/>
[ instructions.html 14 <property name="temperatureImplDir" value="${temperature.dir}/imp"/>
15

les. rti .
.examp ESpm_PE €5 <property name="temperature.ear"” value="%{dist}/temperaturetar"/>»

' . . 16
Figure 7. Adjusting the build.xml file.

As another prerequisite we need to import some ant tasks and create the server control pane
for wl_server, but this is already set up from the last project. Please refer to.
http://weblogic-corner.blogspot.de/2012/03/wls12c-and-oracle-enterprise-pack.html

For convenience we display the ant runtime configuration with the additional tasks and their
corresponding class definitions in the weblogi.jar file. It is available from the main menu
“Window->Preferences”.

— — - — B

type filter text Runtime fe=1E - v
General = Settings used MA nt buildfiles: -
ADF —
Ant e Classpaﬂl‘ 21 Tasks I<§> Types | <0 Properties

i . _Name Class Logation ) Co + Add Task... ]
_ Ew\depluy weblogic.ant.taskdefs.management WLDeploy ~ Dy/100racle/01Middleware/wlserver_12.1/server/lib/weblogic.jar
ApRATEY c 7] openbrowser weblogic.ant.taskdefs.utils.OpenBrowser D:/100racle/01Middleware/wlserver_12.1/server/lib/weblogic.jar Bt Task L
2::5::;”2?;?’_11 1 %w\mmpﬂe weblogic.anttaskdefs.build WLCompileTask D:/100racle/01Middleware/wlserver_12.1/server/lib/weblogic.jar Remove
Help ¥ wlappc weblogic.anttaskdefs j2ee. Appc D:/100racle/01Middleware/wlserver_12.1/server/lib/weblogic.jar |
Install/Update e e. a .€ e.core.resources.ant. a Ui lUoracie\ULmMiaaleware\oepe_LZ L LUU\CONTIQUration\arg....  or¢ =
Java @ edlipse.ncrement..  org.eclipse.core.resources.antincrementalBuild  D:\100racle\01Middleware\oepe_12.1.1.0.0\configuration\org... ~ or¢
Java EE L @ eclipse.refreshLocal org.eclipse.core.resources.antRefreshLocalT..  D:\100racle\01Middleware\oepe_12,1.10.0\configuration\org..  org
Java Persistence & emf.JETEmitter org.eclipse.emf.anttaskdefs.codegen JETEmit.. D:\10Oracle\O1Middleware\oepe_12.1.1.0.0\configuration\org... or¢
JavaSeript & emf.JETCompiler org.eclipse.emf.ant taskdefs.codegen.JETCom... D:\10Oracle\O1Middleware\oepe_12.1.1.0.0\configuration\org...  or¢ |
Mylyn @ emf.)Merger org.eclipse.emf.anttaskdefs.codegenJMerge..  D:\10Oracle\O1Middleware\oepe_12.1.1.0.0\configuration\org...  or¢
Plug-in Developmer @ emf.uti.RemoveV.. org.eclipse.emf.ant.taskdefs.RemoveVersionT.. D:\100racle\O1Middleware\oepe_12.1.1.0.0\configuration\org....  org¢ |
PyDev @ emf.Ecore2)ava org.eclipse.emf.importer.ecore.taskdefs.Ecor..  D:\10Oracle\01Middleware\oepe_12.1.10.0Nconfiguration\arg... ~ or¢
Run/Debug - & emfJavazlava org.eclipse.emf.importer.javataskdefs.JavaGe.. D:\10Oracle\O1Middleware\oepe_12.1.1.0.0\configuration\org... or¢
Cam ] & omf Rnse? laua ara erlines emf imnarter rase taskrsfs Rnzat  DAINOracle\n1Middlpwaretnena 12 110 Mranfiuratinniara are =

® o [ e

Figure 8. Adding additional ant tasks to eclipse.

Now we are ready to build, deploy and run the example.

3.3 Build and Run the example

Although there is support for web services in eclipse through the Web Tools Platform
(http://www.eclipse.org/webtools/ws/) or through the OEPE
(http://docs.oracle.com/cd/E14545_01/help/oracle.eclipse.tools.common.doc/html/index.html
#webservices), we use neither of these options. We rather stick to the ant file is part of the
imported example, since our goal is to demonstrate the integration of this example into
eclipse.

Therefore we open the build.xml file in the project webservices-wsdl2service. If we switch to
the Java EE Perspective, we should see the outline view on the right hand side. Otherwise we
open the outline view from the “Window” menu. This is depicted in the figure below.
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< Java EE - webservices-wsd|2service/wsdl|2service/build.xml - Eclipse Platform gni

File Edit MNavigate Search Project Run Window Help
il -0~  H-E- BE®C D 5 JE @ 7 (¥ Java e | & Jav.
v Bl v 45 & v -
l [ project Explo 52 |3 Package Expﬂ = B[4 buildsml 52 = El\ £Z Qutli SS\I =B
ﬁ“«fﬂ & v 1 i
o P - 18 <!-- Names of deployed Web Services --» . a
iz websenvices-wsdi2service 19  <property name="temperature.ear.deployed.name"” value="Tem o P BRS R
src 28 <0 dist -

7 wsdl2service/client
=) JRE System Library [jdk150_29]

21
22

property name="clientclass-dir" value="${example.output}/c

<Br temperatu
E <E’ temperatu

= wsdlZservice 23= path id="client.class.path"> <@ temperatu
& dlient 24 <pathelement path="%{clientclass-dir}"/» @t t
) 25 «<pathelement path="%{java.class.path}"/> emperatu
& dist 26 [path> <B> temperatu
[ output 27 <@ clientclass:
= wim 28 !-- Run this Ant task to generate a JAR file that contains 1+ <% client.class
29 interface file and data binding artifacts, then code <0 wedle
T4 examplexm E? :;;esz:jtic;mpler:ents the interface, adding the busin <0 jwsc =
[ instructions.htm! - . - . . < clientgen
. 32 taskdef name="wsdlc" classname="weblogic.wsee.tools.anttas
examples.properties 33 taskdef name="jwsc" classname="weblogic.wsee.tools.anttask
% webservices-wsdi2service2 - serieieieme="clientoen"
= wi_server I # 1 Ant Build Alt+Shift+X, Q Run As 4
% 2 Ant Build... Debug As 4
i 3
External Tools Configurations... Bichieles
v T Validate
40 Cpen Javadoc Wizard...
S| y Team +
[£1 markers ] properti | 4 servers 22 m WLST He}@; Compare With 3
Replace With 4
E@ Oracle WebLogic Server 12c (12.1.1) at localhost [wl_se Eanrae T femies Ctrl+Alt+Shift+Down
4 L 3
B
u

Figure 9. Using the ant script to build and run the project.

Now we right-click the target, we want to run and choose “Run As-> 1 Ant Build”. This will
build the project. We start the weblogic server in the server pane and then execute the ant
target deploy in the same manner. Finally we execute the ant target “run” which will start the
client and print output to the console pane.

If we now change the business logic by changing the return value to 101.0f in the
implementation file of the web service as indicated by the picture below, we can use the ant
file to go through the full edit-build-test cycle.

) Project Explorer | [ Package Explorer &3

=0

1 build.xm ( TemperaturePortTypelmpljava &2

B ¢ ~

iz webservices-wsdl2service

[ src
7 wsdl2service/client
=) JRE System Library [jdk160_29]
= build
= wsdl2service
(= dist
(= output
= clientclasses
(&= temperature
= imp
= net
(= xmethods
= sd

i [, TemperaturePortTypelmpl.java
= jws

(= wsdl_files

&1 build.xml

%] examplexml
[E5 instructions.html

1 package net.xmethods.sd.temperatureservicewsdl;
2
= import javax.jws.WebService;

import weblogic.jws.*;

4
5
6= /**
7 * TemperaturePortTypeImpl class implements web service endpoim
8

9 (@WebService(
16

serviceName="TemperatureService"”,

targetNamespace="http://www.xmethods.net/sd/TemperatureServic

endpointInterface="net.xmethods.sd.temperatureservicewsdl. Tem
@WLHttpTransport(contextPath="soap/servlet”,serviceUri="rpcrout
public class TemperaturePortTypeImpl implements TemperaturePort
6= public TemperaturePortTypeImpl() {

b

= public float getTemp(java.lang.String zipcode)
{

/1 TOD puidiiiiniey 1 th your impl here

retur

Seite 6/9



http://weblogic-corner.blogspot.com 30.03.2012 16:38:00
WLS12¢_WS_from_WSDL.docx

Figure 10. Editing the business logic of the web service.

After executing the ant targets build-redeploy-run, we observe that the client output reflects
our change and prints out 101.1

34 Configuring on-the-fly compilation support

Although we do not use the JDT for building our project, we want to use the compiler support
during editing. Therefore we have to adjust the Java Build Path. In a first step we include the
I|brary weblogic.jar, thus eliminating all include errors.

= Properties for webservices-wsdl|2service IEl_lg

type filter text Java Build Path v

[ Resource

AppXray

Java Build Path
I+ Java Code Style

I+ Java Compiler
I» Java Editor

| [ Source | = Prcgectl =h lerarlesl % Order and F_xportl

Add JARs...

Add External JARs...

Javadoc Location Add Variable...

I |
| |
I )
Project Facets [ Add Library... ]
l |
l |

Project References
Refactoring History
Run/Debug Settings
Service Policies

I» Task Repository l
Task Tags

I» Validation ’ Remove ]
WikiText

Add Class Folder...

Add External Class Folder...

Edit... ]

Migrate JAR File...

Figure 11. Adding weglogic.jar to the Java Build Path.

As indicated in the figure above, we open the project’s property window and add the external
library weblogic.jar to the Libraries tab of the Java Build Path.

Since we want to edit the file TemperaturPortTypelmpl.java we add the start folder of the
package name to the “Source Folders” of the Java Build Path as indicated in the picture
below.
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[t Project Explorer [[# Package Explorer! &3 = B || 4] fremperaturePortTypelmpljava 2 ] build.xml | TemperatureClient,java
= ~|i\m 1 package net.xmethods.sd.temperatureservicewsdl;

) 3= import javax.jws.WebService;
2 src 4 import weblogic.jws.*;
4 5% wsdl2service/client
4 i (default package)
4 | TemperatureClient,java
4 1 TemperatureClient

4 iz webservices-wsdl2service

* TemperaturePortTypeImpl class implements web service endpoi

@ebService(

-5 F—
@ ma New y gme="TemperatureService",
150 Temperature, mespace="http://www.xmethods.net/sd/TemperatureServi
Go Int p p p
|55 wsdl2Service DADLO Interface="net.xmethods.sd.temperatureservicewsdl.Te
5% Wsdl2Service Open in New Window hs :?"t(contextEat::"soipfiel:'\rlit“,sir'uiceUr'i:;r'pc;ou
. hra . 55 TemperaturePor eImpl implements TemperaturePor
=i JRE System Libre  gpgy Alt+Shift+w » P ypetmps imp
=), Referenced Librg
& build = Copy Ctri+C emperaturePortTypeImpl() {
4 = wsdl2service E=  Copy Qualified Name
+ = dist 5 Paste Ctri+v
4 (= output % Delete Delete L0at getTemp(java.lang.String zipcode)
» [ clientclass
- Remove from Context Ctri+Alt+Shift+Down
4 [ temnerat 1 1
P Build Path v | 52 [luse as Source Folder E
4 (= imp o - p -
et e Alt+Shift+T » | . Confiaure Build Path 1@ WebLogic Web Service Annotatic
e ;&3 g Build] D\100racle\01Middleware\jdk
= | &2 Import...
“1ea Export... |
vice class name is TemperatureService
= Refresh F5 [ttype name is TemperaturePortType
- = jws Assign Working Sets... wice impl name is TemperatureService_Impl
> wsdl_files | .. . .
'f? T Validate piling 4 source files to D:\11lEclipse\workspace@l\we
2 build.xml |
Run As L4

¥ examnle.xml

Figure 12. Adding a package folder to the source folder of eclipse.

Therefore we open the Package Explorer and expand the top folder of the folder tree we want
to include. From the context menu we choose “Build Path->Use as Source Folder”

If we open the file TemperaturePortTypelmpl.java we now have compilation support and we
recognize that the JDT complains about the compile error “TemperaturePortType cannot be
resolved to a type”. This interface is generated with wsdlc and is included in the
TemperaturService_wsdl.jar as show in the picture below. However we cannot add it to the
build path libraries because the jar file only contains the uncompiled java class which is not
recognized as java type.

BN Eingabeaufforderung . — - . —

D:~11EclipsesworkspaceBil~webhservices—wsdl2service usdl2servicer~outputstemperaturesjuws>jar tuffiTemperatureService_wsdl. jar
2 Yed fApr B4 21:20:38 CEST 26812 META-INF-MANIFEST.MF
Wed fApr :28: META-INF~
Hed fApr B H META-INF/binding—file.ser
Wed Apr 2@: META-INF/binding—file.xml
Wed Apr 2@: META-INF/binding—mapping—file_szer

Wed Apr B H net/

Wed Apr B H net/xmethods

Hed Apr :2@: net/xmeth
B Hed Apr t2@: e e e haidalum R o,y

Wed Apr 28: A net/xmethods/sd temperatureservicewsdl/TemperaturePortType. java
B Wed Apr

Wed Apr :28: wsdls TemperatureService .usdl

Figure 13. Contents of the generated jar file.

Alternatively we could unpack the jar file and add it to the source path. But we rather ignore
the compile error.

35 Create an ear archive

If we want to deploy the web service on a remote weblogic server, it is more convenient to
package it into an ear archive. Therefore we add an additional ant target to our build.xml file.
We need to include the ant task wilpackge first which is depicted in the next figure.
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A .. B R
- T e .
type filter text Runtime =1 -
General = -
ADF Name Class Location Contrik: * Add Task...
Ant %wldepluy weblogic.ant.taskdefs.management.WLDeploy  D:/100racle/01Middleware/wlserver_12.1/server/lib/weblogic.jar ',
dite ¥l openbrowser weblogic.ant.taskdefs.utils.OpenBrowser D:/100racle/01Middleware/wlserver_12.1/server/lib/weblogic.jar
| 5 2.W|EDH’\D\|E weblogic.ant.taskdefs.build WLCompileTask D:/100racle/01Middleware/wlserver_12.1/server/lib/weblogic.jar L
| AppXray — blaai Lol D:/100racle/01Middleware/wlserver_12.1/server/lib/weblogic.jar
Ll Data Management Z_wlpackage I I weblogic.anttaskdefs.build WLPackageTask I D:/100racle/01Middleware/wlserver_12.1/server/lib/weblogicjar =
Il GlassFish Preferences— eclipse.convertPath  org.eclipse.coreresources.ant.ConvertPa D:\100racle\01Middleware\oepe_12.1.1.0.0\configuration\org.ecli..  org.ecl
| Help @ edipse.increment...  org.eclipse.coreresources.antIncrementalBuild - D:\100racle\O1Middleware\oepe_12.1.1.0.0\configuratiom\org.ecli..  org.ecl
H Install/Update @ edlipse.refreshLocal org.eclipse.coreresources.ant.RefreshLocalT..  D:A\l0Oracle\O1Middleware\oepe_12.1.1.0. 0\configuration\org.ecli.. ~ org.ecl
Java & emf.JETEmitter org.eclipse.emf.anttaskdefs.codegen JETEmit.. D:\10Cracle\01Middleware\oepe_12.1.1.00\configuration\org.ecli.. arg.ecll
Java EE @ emf.JETCompiler org.eclipse.emf.ant.taskdefs.codegen.JETCom... D:A100racle\01Middleware\oepe_12.1.1.0.0\configuration\org.ecli.. org.ecl
Java persistence & emf.Merger org.eclipse.emf.ant.taskdefs.codegen.JMerge... D:\10COracle\01Middleware\oepe_12.1.1.0.0\configuration\org.ecli... ~org.ecl
i::':impt - @ emfuti.RemoveV.. org.eclipse.emf.anttaskdefs.RemoveversionT... D:A\l0Cracle\01Middleware\oepe_12.1.1.00\configuration\org.ecli.. org.ecl
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Figure 14. Including wipackage to the ant runtime.

In the build.xml we add the following target, which can be executed after the build.service.ear

and create deployable archive in the distribution directory.
<target name="build.service.ear">
<wlpackage tofile="${dist}/temperatur.ear" srcdir="${temperature.ear}"
destdir="${temperature.ear}" />
</target>

We can also add an additional target to deploy our ear file instead of the exploded version.
<target name="deploy.ear">
<wldeploy action="deploy"

name="¢${temperature.ear.deployed.name}"
source="${dist}/temperatur.ear" user="${wls.username}"
password="${wls.password}" verbose="true"
adminurl="t3://${wls.hostname}:${wls.port}"
targets="${wls.server.name}" />

</target>

We have to run this target manually because it is not included in the dependency list of the
default target. We test it with the same client and it certainly produces the same result.

4 Conclusion

In this little workshop we showed how to integrate a simple web service example into an
eclipse project which features context help, code assistant and on-the-fly compilation. Starting
from a running example, which is part of the WLS installation, we produced an eclipse
project which builds, deploys and runs this example. However instead of changing code with
a text editor as it would be required in the original example, we now have the full IDE
support. This enables us to quickly extend it to include code for prototypes and tests
scenarios.

This workshop exemplifies an approach for taking any of the WLS examples and convert
them into mini projects that could be deployed in complex environments for prototyping or
analysis purposes.
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